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Credits

This program was developed by Allen C. Kempe (CompuServe Id 71220,23) with the 
collaboration of Paul Hachey (CompuServe Id 76625,2644) who designed the Icon, Cover 
screen and provided many ideas which influenced the look and feel of PixFolio and lent other
invaluable assistance in the testing and development    stages.

This software is based in part on the work of the "Independent JPEG Group".

The Author may be reached via CompuServe or by writing to:
Allen C. Kempe
298 W. Audubon Dr.
Shepherdsville, KY 40165-8836
USA
(502) 955-7527

The Index contains a list of all Help topics available for the Help Example. For information on 
how to use Help, press F1 or choose Using Help from the Help menu.



Capture Menu

The Capture menu includes commands that enable you to capture the contents of other 
windows, including those in other applications.

Window Capture an entire window.
Client Capture only the client area of a window.
Full Screen Capture the entire video display.
Capture Hide Toggle option to hide PixFolio while doing    capture.



Catalog Menu

The Catalog menu includes commands that enable you to maintain and view the contents of 
catalogs of images.

For more information, select the Catalog menu command name.

Select Catalog Add, delete, rename or select a catalog.
Catalog                 Catalog an image.; add, delete or update catalog entry.
Browse Browse through a catalog and search for specified criteria.
Build Build a catalog via mass update.
Print Print the contents of a catalog.
Thumbnail ViewDisplay catalog as a    grouping of small thumbnail images.
Alpha Sequence Display thumbnails in Alphabetic sequence
Display Hidden Display hidden catalog entries.
Catalog Options Display catalog print options.
Export Export catalog to a comma-delimited file.
Rebuild Index Rebuild a catalog index & recover lost disk space due to deleted records.



Edit Menu

The Edit menu includes commands that enable you to manipulate images, access the 
Windows clipboard and undo a previous operation..

For more information, select the Edit menu command name.

Copy Copies an image or selected area to the clipboard
Cut Cuts an area from an image and places it in the clipboard.
Crop Crops an image .
Expand Expand the size of an image.
Resize Resize an image by a given percentage    or rotate or mirror the image.
Palette Paste a palette saved    on the clipboard.
Paste Copies an image from the clipboard.
Undo Undo the last edit operation.



File Menu

The File menu includes commands that enable you to open and save files, delete or move 
files, and to print.

For more information, select the File menu command name.

New Create New Image
Open Open a file.
Save Save a file.
Save As Save a file and optionally convert to another format.
Update Update an OLE object
Close Close the child window.
Move Move or copy a file.
Delete Delete a file.
Launch Launch another application.
Print Print all or part of an image.
Select Printer Select a printer
Tech Info Technical Information
Exit Exit PixFolio



Option Menu

The    Option menu includes commands that enable you to set operating options.

For more information, select the Option menu command name.

Image Options Display image display and print options.
Display Status Toggle display of status bar.
Background Set background color.
DIB To Screen Paint screen with DIBs.
Display Warnings Control Display of warning messages.
Default Options Set program defaults options.
Fix TIFF Fix TIFF files with invalid strip byte counts.
Slide Show Options Modify slide show options.
Auto Dither Toggles Automatic dithering option.
Verify Catalog Toggles catalog index verify mode on and off.



Palette Menu

The View menu includes commands that control how images are displayed.

For more information select the Palette menu command name.
Dib's Display image's palette in a special window.
System Display the system palette in a special window.
Change Palette Change palette.
Gray Palette Gray palette.
Restore Palette Restore palette.
Dither Display options for dithering an image.
Play Image "play" a GIF animation or GIF89a composite image.
Single Step Play Single step through a GIF animation.
Set Play Rate Vary the speed at which a GIF animation "plays".



Window Menu

This menu contains commands that allow you to manipulate PixFolio windows.

Window Tile Arrange all the non-iconic windows so they are positioned side-by side.
Window Cascade Arrange the non-iconic windows so they are staked on top of each 
other.
Window Icons Arrange iconic windows along the bottom of the main window.
Size Window to Image Restore an image's window to the size of the image.
Close All Close all open child windows.
Size to Image Resize window to the image's dimensions.



Glossary
Bitmap
Clipboard
Color Resolution
Device Dependent Bitmap
Device Independent Bitmap
GIF
JPEG
Metafile
OLE



Edit Copy Command

To copy an image to the clipboard, select COPY on the Edit menu. The selection will be 
grayed if no image is being displayed.

 In order to copy part of an image, first locate the cursor at one corner of the area that you 
wish to copy, hold down the left mouse button and stretch the box(known also as a 
marquee) to encompass the desired area. Release the mouse button and then select COPY 
from the EDIT menu.



Edit Cut Command

EDIT-CUT works similar to EDIT_COPY except that it is only effective when an area has been 
selected using the mouse. When COPY is then selected from the EDIT menu, the area will be 
cutout and placed in the clipboard. The background where the image    was cut will be 
painted to the current background color. (See OPTION BACKGROUND).



Edit Paste Palette

This command can be used to replace the palette of the currently displayed image with the 
palette stored with the bitmap in the clipboard. Normally, data is pasted from the clipboard 
using the palette currently in use.



Edit Paste Command

If there is compatible data in the clipboard, it may be "pasted" by selecting the EDIT-PASTE 
command. You can    determine whether there is data in the clipboard by looking at the EDIT-
PASTE menu entry. If it is "grayed", there is no compatible data in the clipboard.

Data to be pasted from the clipboard could have been put there by some other program, for 
example the Windows Paint program or by PixFolio itself,    earlier. 

To paste data from the clipboard, select EDIT_PASTE. The cursor will then change from an 
arrow to a crosshair. Move the crosshair cursor to the upper left corner of where you want to 
place the clipboard data.

When you are at the desired location, press the left mouse button and hold it down. While it 
is down, a marquee of the same dimensions as the clipboard data will be displayed. When 
the marquee    is located where you desire, release the left mouse button and the clipboard 
data will be written to the screen at the location of the box.

When pasting another color image into the current image, the palettes of the two images 
must be the same or one or the other images must be converted to use the palette of the 
other. PixFolio will prompt you if this is necessary. Otherwise, you can use the Palette Dither 
command to do this beforehand.



Edit Expand

This command can be used to expand the area of an image so that additional images can be
pasted together to form a larger image. Alternatively, an image can be cropped.

To change the size of an image, use the mouse to drag the window borders to the    desired. 
size. Then select    EDIT-EXPAND.    If the new borders are inside the old borders, the image 
will be cropped, otherwise it will be expanded. Edit Expand does not alter the aspect ratio of 
the image, this can be done with Edit Resize.

The expanded area of the image will be colored to the Background color. (see OPTIONS-
BACKGROUND).

Edit Expand does not alter the aspect ratio of the image, this can be done with Edit Resize.



Edit Resize

Use this option when you wish to resize an image (make larger or smaller) by a specific 
amount. You will be presented with a dialog box with two values to be inputted, one for the X
(width) dimension percentage and the other for the Y    (height) dimension. The default value
for both is 100 (%).    Accompanying each percentage input box is an alternative pixel size 
edit box which can be used as an alternative to the percentage change. Any change entered 
into the size box will be automatically reflected in the pixel size and vice-versa.

The height can be changed    independently of the width and vice-versa allowing an image to
be "stretched" one way or the other.    For example to increase the width by 50%, type in 150
for the X dimension percentage and leave the Y at 100%. For best results, the increased or 
decreased    image should be some multiple of the original, otherwise the image will be 
distorted. 

Note: the default dimensions for Edit Resize are those of the physical window. Therfore, you 
may stretch the window out to the desired dimensions prior to selecting Edit Resize and then
using these defaults to resize the image.

Flipping an Image

Two check boxes allow for reversing the image along the Y axis (left - right) or along the X 
axis (top - bottom) or along both.    If the X mirror checkbox is checked, the image will be 
reversed top to bottom and if the Y mirror checkbox is checked the image will be flipped left 
to right. Flipping along both axes is equivalent to rotating 180°.

Rotating an Image

Rotation can be specified along with flipping or resizing. In the Rotate group box are four 
radio buttons, "none", "90°", "180°" or "-90°". If rotation is specified, the image will be 
rotated first and then the flipping and/or resizing will be done.



Edit Crop

This command may be selected to crop the image to the dimensions of the current selection 
rectangle or the window borders.    The selection rectangle can be drawn by holding the left 
mouse button down at the upper left-hand corner of the area that you want to enclose and 
then dragging the mouse to stretch    the rectangle out. When you release the mouse button,
the rectangle will stay on the screen and EDIT CROP can be selected to crop the image to 
the size of the rectangle.



Edit Undo

Sometimes it may be desirable to "undo" the previous edit operation if the result is not what 
was desired. 

PixFolio saves the current image before performing any operation on it so it is possible to 
back up by selecting EDIT-UNDO..

Note: The undo buffer is only one deep. You can only undo the last operation. It would be 
wise to save your file at critical steps if necessary.



File Open Command

Select this command to read and open a new image for viewing. If the file is cataloged, the 
CATALOG-BROWSE command may also be used to open a file.

Multiple selections may be made by clicking on each file that you wish to load. If desired, 
images may be initially displayed as iconic if the "Minimized"checkbox is checked.

PixFolio will automatically    specify a list of extensions to search for. This default extension 
list is loaded from WIN.INI whenever PixFolio starts up; different file extension lists can be 
established for each catalog. If you do not want to default to certain file extensions, the 
entry "Extensions=" under [PixFolio] in the WIN.INI file and for each catalog in the Catalog 
Select command may be changed to suit your requirements. A valid file extension list is of 
the form "*.xxx; *.yyy;" etc. Note that each extension is separated by a semicolon ";". 

Favorite Directories

PixFolio automatically keeps track of the 5 most recent paths selected by a File Open 
command. These paths are saved whenever PixFolio ends and will be displayed the next 
time that PixFolio is started. Whenever one of these selections, whicha re added to the end 
of the File menu are selected, the File Open Command will be initiatied using that path as 
the default. 



File New Command

Select this command when you wish to create a new image. File New will create a blank 
image that you can paste to from the clipboard.    A dialog box allows you to size the image 
to the current window , the image stored in the clipboard or to any other size that you wish.
The "Reset to Window" button will reset the X and Y    dimensions to that of the currently 
displayed window while "Reset to Clipboard" will reset the X and Y dimensions to that of the 
image in the clipboard ( if present). Otherwise you can enter the size of the new image 
manually.

Controls are also provided to establish the color resolution of the image ( 2, 16 , 256 or > 
256 colors) and the palette which can either be a stock 16 or 20 color palette, a generalized 
256 color palette or the palette from the clipboard.



File Print Command

Select this command to print the currently displayed image. A portion of the image only may
be printed by first using the mouse    to (see Copy) select a rectangular area to print.

A dialog box enables you to scale the image by a percentage; or you may    specify the 
picture size in pixels. The scaling can be specified differently for the horizontal and vertical 
dimensions. For your convenience, the picture's dimensions in inches will also be displayed. 
If your printer cannot    directly print a color or gray scale image, the picture will be dithered 
if the "Dither" check box is marked. 

Note: Printing takes a long time. Printing once initiated, can be canceled by pressing 
"Cancel" in the dialog box that is displayed while printing is taking place. Or a print job can 
be canceled via the Print Manager.



File Select Printer

This command can be used to select which printer you wish to use for a subsequent print 
command. Depending upon the printer, you may also be able to set various printer options .

Use the Options button to change printer dependent options; for example graphics 
resolution or landscape mode.    These options are a function of the print driver.



File Save

Use this command to save a file in the same format that it was read and without changing 
the name.    This command will not be available for those file formats that are supported for 
read only.



File Save As Command

Select this command to save an image or create a new copy of an image in a different 
format.

FILE_SAVE_AS defaults to the current filename. If you wish to change the name and/or 
directory, you may do so. You may select the output file format using the listbox provided in 
the File Save dialog.

Graphic Formats:

Graphic formats supported by PixFolio are:
BMP Windows bitmap format.
CLP Windows clipboard file(Read Only)
EPS Encapsulated Postscript    imbedded TIFF preview images.(Read Only)
FLI/FLC/CEL Autodesk animator animation files. (Read only)
GIF CompuServe Graphics Interchange Format. PixFolio    supports both the GIF87a and 

GIF89a standard. ("The Graphics Interchange Format (C) is the Copyright property of 
CompuServe Incorporated. GIF(sm) is a Service Mark Property of CompuServe , 
Incorporated.")

ICO Windows Icon. (Read Only)
IFF/LBM/CE Deluxe Paint II LBM & IFF files. The file extension "CE" is created by Digital 

Vision's Computer eyes video capture product. 
IMG GEM/IMG (Digital Research) (Read Only)
JPG JFIF format JPEG coded files.
MAC Macintosh MACPAINT files(Read Only)
PCX Z-Soft Paintbrush files.
RLE Compuserve Run Length Encoded file format.(Read Only)
TGA Targa file format.    (True Vision Advanced Raster Graphics Array)
TIFF Tagged Image format.
WMF Windows metafiles. 
WPG WordPerfect Graphics (Read only)

Options

If there are any options for a given graphics format, an "Options" button will be provided, 
Many graphics formats allow for writing the output image in different levels of color 
resolution and various compression methods.

Color Resolution Formats

Images can be saved in    several resolutions:
1 BPP I bit per pixel or two colors, black & white.
4 BPP 4 bits per pixel or 16 colors.
8 BPP 8 bits per pixel or 256 colors.
24 BPP24 bits per pixel or 16 million colors. 

The Color resolution selected will determine the maximum number of colors in the saved 
image. If this is less than the current resolution of the image then the current colors will be 
converted to the nearest color available in the reduced resolution.

Not all file format and color resolution combinations    are valid either because the 
combination is not supported or because the format specification does not provide for it.    
Invalid color resolution options will be "grayed" and cannot be selected.



GIF animation files    cannot be saved. In this case what will be saved is the image that is 
displayed when File Save is invoked.

File Compression

Although most of the file formats supported provide for compressing the pixel data, PixFolio 
currently only supports compression for    GIF, JPEG, PCX , TARGA & RLE and TIFF files. PCX, 
TIFF and TARGA files    can be saved    in either compressed or non-compressed format. The 
GIF format is always compressed. When PCX , TIFF or TARGA is chosen, a check box will be 
displayed.; if checked, the file will be compressed otherwise it will be written uncompressed.

JPEG files' compression ratio is defined as a "quality" factor in the Options dialog for this 
format. "75" is the default value and generally gives the best compression ratio with the 
least loss of detail. A value of 100 implies no compression. Values lower than 75 may result 
in unacceptable image degradation as JPEG is a "lossy" compression method in comparison 
to compression methods used for other graphics formats.

Although the format specification provides for several types of compression to be used for 
TIFF files, PixFolio only writes files with Packbits compression for 2 color images and LZW 
encoding for 16 color or greater images.



BMP Options

Select the color resolution and format, whether Windows or OS/2 PM.



FILE OPTIONS

Select the desired color resolution and whether you want to compress the output file.



GIF Options

Select the desired color resolution and whether you want to write the file in interlaced 
format. 

Turning GIF89a on results in adding the contents of the Description field in the catalog entrty
to the GIF file as comments. The catalog containing the item must currently be selected.



JPEG Options

There are two options.: The spin buttons set the amount of compression.. 100 - no 
compression to 0 all compression. For most purposes, 75 is optimal and is the default. Lower
values will result in smaller files with a corresponding decrease in image quality. 

The Optimize Entropy Encoding option, if turned on, results in better compression but with a 
performance penalty; i.e. it takes longer.



File Delete Command

Selecting this command will cause the currently displayed image to be deleted from its 
location on disk. If the file is present in the currently selected catalog, it will be deleted from 
there as well. FILE_DELETE will not deleted catalog entries from other than the current 
catalog. 



File Move/Copy Command

This command may be selected to move or copy the currently displayed file to another 
location.    For example, to organize your files or to create a backup copy. The change of 
location will be updated to the catalog. 

Move/Copy does not change the file's format. It simply copies the disk    data from one 
location to another.    "Move" implies that the original file will be deleted after copying. To 
copy, that is to say, end up with two copies of the file, select the Copy option checkbox.

If the file is located in the currently selected catalog, the catalog entry will be updated to 
reflect the new location of the file. If doing a move or copy and the file is renamed, the 
catalog entry will also be renamed. 



File Close Command

This command will cause the active Child window to be closed.



File Tech Info Command

If an image is currently displayed, this option will display a dialog box that contains a 
scrollable window that lists various technical attributes of the file. Also, if any errors were 
encountered while reading the file, they will be displayed here.

The technical attributes of a file format may be significant when attempting to which 
determine specific format options are used. For example, if the file is compressed, it will be 
displayed here. PixFolio does not support all permutations of format options for all files and 
of course is unaware of new options that might be added to a format specification in the 
future.

The format and content of the display is dependent upon the file format; some formats may 
display more information than others.



File Update

This menu selection replaces the File Save command when PixFolio has been called as an 
OLE server. Executing this command will update the OLE client application with the image 
that you have selected.



File Exit Command

Use this command to exit PixFolio.



Catalog Select Catalog Command

This command will cause a dialog box to be displayed that will enable you to select, add, 
delete or change the name of a catalog. 

A catalog has a "Title" which can be anything that you wish it to be. It could be descriptive of
the type of images, e.g. "GIF 640x480" or relating to a topic, e.g. "Nature". Each catalog has 
a DOS file name and path associated with it.    This path will also be the default path for files 
in that catalog.    Another    property associated with a catalog is the default extensions for 
files that will be displayed in the File Open and Catalog Build dialogs.

The first time that    PixFolio    starts up, it will create a catalog titled "Default" and named 
"PIXFOLIO.CAT (its corresponding index is PIXFOLIO.CIX). The default catalog and its index 
will be located in the same directory as PIXFOLIO.EXE.

You may establish as many catalogs as you wish. The names of defined catalogs and their 
pathnames    are saved in WIN.INI. 

Select New Catalog
PixFolio can only work with one catalog at a time although different Thumbnail Views can 
each reference a different catalog. This requires you to "select" which of the catalogs that 
you have defined. Until you change the selection, this is the catalog that will be updated by 
any subsequent catalog commands.    

To select a catalog, highlight the desired catalog in the Catalog combo box. Make sure that 
the "Select New Catalog" radio button is checked and press "OK".

Change Catalog Title / Ext 
Highlight the catalog whose title you wish to change. You may also change the list of file 
extensions that will be displayed in the File Open and Catalog Build functions while this 
catalog is selected. You may also change the optional volume ID. Then check the "Change 
Catalog Title". Next, enter the new name in the Catalog Title edit box. Then press "OK".

When a new catalog is selected, the current directory will be set to that of the Catalog's file 
name.

Note: changes to the default extensions for a catalog will not be effective until that catalog 
is selected again.

Delete Catalog
Highlight the title of the catalog you wish to delete.    Then check the "Delete Catalog" radio 
button. Then press "OK".

Create New Catalog
Press the "Create New Catalog" radio Button, fill in the title of the catalog in the New Title 
edit box. Next, enter a filename for the catalog. An extension is not necessary! Use the file 
list box to select a path to where the catalog should be placed , enter a list of file extensions 
to be in effect for this catalog and then press "OK".

An optional volume ID field is provided. If present, the volume label of the drive will be 
checked and you will be prompted to mount the requested volume if it is not already 
mounted.

Note: It is suggested that the catalog be placed in the directory where the majority of the 
files that will be cataloged in this catalog because selecting the catalog will set the current 



directory to that of the catalog file name.

Default Catalog

The default catalog, that is to say, the catalog that will be selected upon startup, is definable
via the Option Default Options command. 

Other Options

The Info button can be used to display the current storage requirements of a catalog. From 
this information, it can be easily determined whether the catalog file would benefit from re-
indexing.

Catalogs can be marked Read only.  In this case, they cannot be updated or modified. The 
Catalog Build and Rebuild Index functions will not be allowed and Catalog Browse and 
Catalog Catalog will not allow any information to be changed. 



Catalog Catalog Command

This command can only be executed when an image is being displayed.    This command is 
used to add or update an entry in a selected catalog. The previously selected catalog will be 
used but can be changed by selecting a new catalog with the Catalog combo box.

Selecting this option will bring up a dialog box with a number of fields that you can enter 
into. Other fields are updated by the program.

User Fields
Title This is the title of the image. If a GIF89a image has a title, it will be filled in 

automatically. The maximum number of characters that can be entered is 59, 
including carriage returns and line feeds.

Keywords This field can contain a      number, up to the length of the entry box, of 
keywords to be used for searching. These keywords can be used to select    a 
list of files meeting requested search criteria. The maximum number of 
characters that can be entered is 87.

Description This field can be used to enter any descriptive data concerning the file up to a 
limit of 1200 characters. This field can be scrolled and edited using standard 
editing commands. If a GIF89a image has text data included with it, it will be 
placed here.

Program Fields:
Filename The name of the file.
Icon This is a postage size view of the image. Clicking on the image will cause it to 

be regenerated.
Pathname The primary location (hard disk) pathname and volume label are displayed as 

well as the backup(floppy disk) location. Therefore, there can be two access 
paths for the file.

Info The height, width , number of color bits and file format are displayed in a box in the 
lower left corner.

There are several functions which can be performed by pressing the following buttons:
Catalog/Update Update the catalog; "Catalog" means that this is a new entry. If desired, the 

target catalog can be changed beforehand.
Uncatalog    Delete the catalog entry. This button will be grayed if there is no catalog entry 

to delete. This option does not delete the file itself.
Cancel Cancels the dialog and returns you to the main menu.
Move Moves the file to some other location.
(image) The "thumbnail" image is itself a button. When the original image is displayed,

clicking on the "thumbnail" will cause it to be re-generated. this is useful if you
had previously cataloged the original image and now have made a change to 
it like brightening it or cropping it.    In Browse mode, clicking on the image has
no effect.

Note: The above buttons are redefined if the dialog is entered via the CATALOG_BUILD 
command.; "Catalog" or "Update" becomes "Next",    Uncatalog becomes "Previous" and 
"Move" becomes "View".



Catalog Browse Command

The CATALOG_BROWSE command provides a dialog box listing the files in a catalog. The 
target catalog can be changed by selecting another catalog from the Catalog combo listbox.

There are a number of functions that can be applied to a file:
Move /Copy File The file can be moved or copied to another location.
Delete File  The file can be deleted from the hard disk. The file is also deleted from 

the catalog.
View Image The file can be opened and viewed.
OK The catalog entry for the file can be viewed and updated. Double-

clicking the file name is the same as pressing the OK button. When the 
catalog entry dialog is displayed, the OK , Delete and Move buttons are
replaced by Prev, Next and View respectively.

Cancel Cancels the dialog returning you back to the main viewing window.
Uncatalog Deletes the file from the catalog only.
Print Cat Prints the selected catalog entry. 

File Search

Four    different search criteria can be applied to a catalog to restrict the catalog list to a 
subset. The four categories    that can be used for the search are:

1. Whether a backup copy exists.
2. File Format, e.g. GIF87a, TIFF, PCX, etc.
3. Match on one or more keywords.
4. Match on special conditions, e.g. file size, width, height, number of colors or 

backup volume name.

The Search    function can be accessed by pressing the Options >> button:

After a search operation.

To search, place the desired search value(s) in either the Format edit box    (29 characters 
max.), Special    Conditions (87 characters max) or the Keywords (87 characters max) edit 
box. If nothing is put    in a box, it will not be used in the search. The "Backup File" checkbox 
is a three-state control. If the box is gray, then it will have no affect on the search. If the box 
is blank, then all catalog records that do not have a backup location will be selected. If the 
box is checked, only those catalog records with a backup file location will be selected. The 
three search criteria are ANDed to select    a record. That is to say, if search criteria 1 
(Backup) is satisfied AND search criteria 2 (File Format)    AND search criteria 3 (Special 
Conditions) AND search criteria 4 (keywords) are satisfied, the record will be selected.

Wild card characters "*" & "?"    can be used in search arguments. For example, to select all 
"GIF" files, the search argument "GIF*" will select both GIF87a & GIF89a". Either spaces or 
Commas may be used to separate    search arguments. The underscore character "_" may be
used in place of a space in a search argument if that space is significant. For example 
STAR_TREK will search for the string "Star Trek" while STAR TREK will hit on either "Star" or 
"Trek".

In order to include in the search special conditions such as file size, image width, etc, 
PixFolio has    5 special search arguments that can be used in the Format and Special 



Conditions boxes. Do not use one of these special codes in the Keywords box! The special 
codes all start with an "@" sign followed by a Code for the particular value to be tested for, 
an operator ( "<" - less than, "=" - equal . "#" - not equal, or ">" - greater than) , followed 
by the value to be tested for.

The valid codes are:

"B" - backup volume name.
"C" - number of colors, 2, 16, 256.
"D" - date in the format defined as the short date format in the International section 
of Control Panel.
"H" - height of image.
"P" - primary path name
"S" - file size in bytes.
"W" - width of image.

Some examples:
@W=320 select images whose width is 320 pixels.
@D>01/03/1991 select all dates later than January 3, 1991.(default US date format)
@B=GIF0020 select all images residing on backup volume "GIF020"
@C>16 select all images with more than 16 colors.
@P=C:\PIXFOLIO select all images in subdirectory "C:\PIXFOLIO"

The catalog will be searched for records meeting the desired criteria when the Search button
is pushed. At the completion of the search, the new catalog list will be displayed in the 
listbox.    To change the search criteria, enter new search values and press Search again.

The modified catalog list will be in force until the "Show All" button is pressed, a new catalog
is selected or another search operation is performed. The CATALOG THUMBNAIL VIEW 
command will only display the currently selected catalog entries. 
 



Catalog Build Command

This command    provides the ability to select    one or more files from a specified input 
directory for automatic updating to the catalog.
 
The list box will display those files in the selected directory that are not cataloged unless the
"Show All" checkbox is marked. All files in the list can be selected    for building by clicking on
the "Select All" check box.; all files will be highlighted. Any files that are not desired can be 
de selected by clicking on the file name. Clicking on the "Select All" box a second time will 
un-highlight all files. If the Follow Directory Tree checkbox is checked, the listbox will display 
all files in subdirectories of the current directory.

All highlighted files will be cataloged if they are not already. PixFolio will not bother to read 
images into memory that are already cataloged unless the Force Update checkbox is 
checked.. However, file volume and pathname information will be updated for existing 
catalog records. This feature provides an easy way to update PixFolio with information on 
backup copies of images stored on your hard disk. Just do a "Build" on the floppy disk in 
drive A or B and the backup location of the files will be quickly updated to the catalog. 
Another use for the "Build" command is to update the catalog to reflect the new locations of 
files on your hard disk after you have moved them outside of PixFolio.

 If the "Auto Update" option is selected. all of the files will be cataloged without any 
intervention; otherwise you will be prompted for each file so that you may fill in the Title, 
Keywords and Description entries. The Auto Update option is useful for mass updates or for 
initial creation of a catalog.

PixFolio may halt for certain errors and warnings if the Option Display Warnings menu 
selection is checked.    You may temporarily enable or disable this feature by checking the 
"Stop on Error" checkbox.      You may also change the default setting via the Option Default 
Options command. This will prevent stopping the build process except for the most serious 
errors. Please keep in mind that processing 24 bit images may cause your computer to 
appear to "hang" while Windows processes the bitmaps. 

The catalog that will be updated can be selected by using the Catalog Combo listbox.



 Catalog Print Catalog

This command will print, the contents of a catalog in two different formats: four per page or 
an "alternate" format that will print an array of thumbnails with only their file names.    The 
four per page format contains the "thumbnail" view of the image as well as text information 
such as title, description, keywords, image size, color resolution,    file size, date, etc.

Only the "selected" entries in the current catalog will be printed.    In order to print selected 
catalog entries, the Catalog Browse and/or the Thumbnail View    commands can be used to 
limit the scope of printing by de-selecting or hiding entries which you do not want to print.

To print a single catalog entry, you can use the "Print Cat" button in the Catalog Browse 
command. To print a more than one "selected" thumbnail, the desired images can be 
"marked" and printed via Thumbnail View - Process Thumbnail.

The Catalog Print dialog allows the user to also select the target printer and to select a font 
to be used. Provisons are also made for printing a selected range of pages. If, for example, 
you selct pages 10-15, then only those pages will be printed. Pages 1-9 will be bypassed and
printing will terminate after page 15 is formatted and sent to the printer.



 Catalog Thumbnail View

This command will create a window displaying a series of small "thumbnail" images in the 
currently selected catalog, side by side . The number of catalog entries displayed depends 
upon the size of the current viewing area; the maximum number of thumbnails can be 
displayed by maximizing the window. Also, the sizing border of the window can be moved to 
increase or decrease the viewing area.

The content of the display can be modified by utilizing the CATALOG SELECT to select a 
different catalog and selecting the CATALOG BROWSE , Search operation to limit the catalog 
list to desired entries. See also Thumbnail View Options. Multiple Thumbnail view windows 
may be opened if desired to display the contents of different catalogs at the same time.

The sequence of the images can be manually established by dragging the thumbnails to the 
desired location. Once this is done, you will have defined what is called a user-defined 
display sequence.    See View Alpha Seq for more info.



Thumbnail View Options

Thumbnails displayed can be viewed by clicking with the left mouse button on them; a new 
document window will be created for the image. (When PixFolio has been called by another 
application via OLE, clicking on a thumbnail will cause the image to be selected as an 
embedded image in the OLE Client application.) Holding the right mouse button down while 
over a thumbnail will display a popup menu with six options, VIEW, INFO, HIDE THUMBNAIL, 
MARK THUMBNAIL , PROCESS THUMBNAILS.    LAUNCH APPLICATION and SLIDE SHOW.

 "View" will read in and display the image. 
"Info" displays a dialog box with text information such as title, description, 

etc. 
"Hide Thumbnail" will delete the thumbnail from the screen just as if it were not 

selected. Hidden    thumbnails can be restored by using the Catalog    
Browse command. 

"Mark Thumbnail" sets a flag for a later Recatalog option to act upon.

"Process Thumbnails" option can be used to move act on marked thumbnails    by 
uncataloging them. moving them to another catalog, copying the 
catalog entry to another catalog, printing them or moving or copying 
files to another storage location.

"Launch Application" can be used to start another application using the selected 
thumbnail.

"Slide Show" will display all marked slides sequentially in full screen mode.

Moving Thumbnails

Individual thumbnails can be moved around the screen by holding the left mouse button on 
the title and dragging the thumbnail to the desired location.    This will automatically 
establish an alternate user-defined sequence for the Catalog. Initially, the default sequence 
is alphabetic order. See View Alpha Seq for more info.

If more than one Thumbail View is active, thumbails can be copied between catalogs by 
dragging them as described above. 

Keyboard control

The Page-Up and Page down keys will scroll the thumbnail display through the catalog list.

The Up-arrow and down arrow will move the display up or down one line respectively.

Selecting VIEW-THUMBNAIL VIEW will cause any currently displayed image in the main 
viewing area to be erased. 



Mark Thumbnail

Selecting this option will "mark" the thumbnail for later action using the Process Thumbnails 
command. When a thumbnail is so marked, the Mark Thumbnail    menu item will be 
checked. Selecting a    previously marked thumbnail will unmark it.



Add Thumbnail

This command is only present when the CATALOG - DISPLAY HIDDEN option is turned on. It 
forces the display of all catalog entries, regardless of whether they ahve been not selected 
or hidden.



Process Thumbnail

This option may be selected to either move marked thumbnails'    catalog entries to another 
catalog, copy the entries to another catalog or uncatalog the entries. In addition, marked 
thumbnails can be hidden, all thumbnails can be either marked or unmarked and finally to 
print marked thumbnails' catalog entries. When you select this option, you will be presented 
with a dialog box from which to select the target catalog for the move and copy options; the 
target catalog is not necessary for the other options which only operate on the current 
catalog. 

The thumbnails to be operated on by this command(except for Mark & Unmark All)    must 
have been previously marked with the Mark Thumbnail command; marked thumbnails will 
display an asterisk "*" prefixed to the file name in the thumbnail's title.



Launch Application

This command allows you to enter the necessary data in order to start another application.
The three edit boxes are titled Program, File and Parameters. 

You must enter into the Program edit    box , the    path and program name of the program 
that you wish to execute. The File edit box will default to the file name that you have 
selected. The Parameters edit box can be used to enter any parameters for the program that
you wish to execute that should follow the file name.

When you have entered the necessary data, press OK to start the program.

See the user guide for information on establishing default program values by file type.



Slide Show

This command will display all marked slides sequentially in full screen mode.    To stop the 
slide show and return to the Thumbnail view, press ESC or click on the screen. As soon as 
the current image has been read    from disk, you will get a dialog box asking if you wish to 
continue..

Image files that are to be viewed with slide show must be present on a hard disk. images 
that are not on a hard disk will be bypassed with a beep. Although Slide Show can display 
any supported format, best results will be obtained by viewing *.BMP files as these generally
take the least amount of time to read in for display. Therefore a display of *BMP files will be 
smoother.

There are several options that affect the slide show. These options can be modified via the 
Options Slide Show Options command.

When in Slide Show, the slide show can be terminated at any time by double-clicking with 
the left mouse button. When the "Pause between" option is active, double clicking with the 
right mouse button will cause slide show to proceed to the next slide.



Catalog Display Hidden

This command can be used to cause all of the entries in a catalog to be displayed regardless
of whether the entry is hidden, not selected or not.    When in effect, it makes it possible to 
"unhide" or add    an entry back to the thumbnail display.



Catalog Options

This command will display a dialog box that enables the following options to be set:
Whether to print catalog entries using the thumbnail image in the catalog or to read in 
the image from mass storage. The latter results in better image quality but takes 
considerably longer.
Whether to dither color images when printing. This option is only necessary if the print 
driver does not produce half-tones or cannot print color images.
Print the "alternate" format with approximately 20 thumbnails per page.
Select the base font for printing the standard catalog listing.



Export Catalog

This command will create a comma delimited file from the currently selected catalog. Such a
file can be read by many spreadsheets and    database programs. Using such a program, you 
can then create customized listings, analysis or other actions of your choosing.

After selecting    this command, you will be presented a dialog box where you can enter or 
select the file name and path of the exported catalog file. 

The format of the exported file is as follows:

File name
Title
Width
Height
Number of Colors (2, 16, 256 or >256)
Format
Primary path
Primary volume name
Backup path
Backup volume name
Keywords
File size in bytes
File creation date
File creation time
Description

Note: Results may be unpredictable if the Title or Description entries in a catalog entry 
contain commas or double quotes, carriage returns or line feeds. 



Catalog Rebuild Index Command

This command should be used when it is necessary to recover lost disk space in a catalog. 
This may be necessary after doing a lot of maintenance to catalog entries, particularly 
editing and adding to descriptions. When the catalog record is re-written, the space 
previously allocated in the file for the record    is not used and either a previously deleted 
record that is large enough is used or the file must be expanded. 

CATALOG-REBUILD    re-writes the catalog    and eliminates any deleted records resulting in a 
smaller catalog file and index.

It is recommended that a backup of the catalog be made before CATALOG -REBUILD is 
executed.

Note: The Catalog Rebuild Command creates temporary work files that have names starting
with ~PXCnnnn.TMP and ~PXInnnn.TMP where "nnnn" is some random number. These files 
are the newly created catalog and index respectively. In the event that the Catalog Rebuild 
should fail, these files may be left on your hard disk and taking up considerable space. 
Normally, they would be deleted when the function ends. The files will be written on which 
ever hard drive on your system which has the most free space. 



Options Options

This command is available whenever an image window is the current MDI window. It will 
display a dialog box showing the status of options relating to the display of the image. Also, 
print scaling and positioning parameters can be specified prior to printing the image.



Options Display Status

This menu item toggles the display of the status bar at the bottom of the main window on 
and off.



Options Background Command

This command can be used to select a background color to be used    when an image is 
resized with the EDIT_EXPAND command. It presents a dialog box that can be used to 
establish a custom color.

The default background color when PixFolio starts is Green. The background color may 
change due to reading in    an image that specifies a background color. GIF files do specify a 
background color.

The background colors that can be selected will be one of the colors in the image's palette.

If the Solid Background check box    is checked, the background will be written with a solid 
color. Otherwise, a dithered color will be used.



Options DIB To Screen

This option controls the way that PixFolio displays images. If this option is checked, the 
screen will be painted directly using the current Device Independent Bitmap (DIB) rather 
than a device dependent bitmap (DDB).    Displaying a DIB is slower than displaying a device 
dependent bitmap. However, the downside is that there could be a lengthy delay, especially 
when 24 bit color images are read in, while the device dependent bitmap is being created.



Options Display Warnings

This option toggles on or off an option to suppress the display of certain warning messages. 
Once you have experience with PixFolio, you may wish to turn this option off. 

Any change to this option affects only your current session of PixFolio. The default value 
upon startup can be set via the Option Default Options command.



Options Auto Dither

If this option is turned on, any image that is read in will be automatically dithered if its color 
resolution is greater than the current video display. For example, if you are using the 
standard VGA driver shipped with Windows,which only supports 16 colors,    you can    still 
view 256 color GIF images by dithering them. Likewise, if you have a display capable of 256 
colors, PixFolio will dither to 256 colors, 24 bit TGA, TIF and PCX images if the auto dither 
option is turned on.

It should be noted that PixFolio maintains the original color data if the image is dithered so 
that the file can still be saved in other formats without losing color information. If you wish to
save    a dithered image, dithered, you must utilize the View Dither Color Image command .

Note, Dithering is slow! Dithering a large 24 bit image to 256 colors may the 
considerable part of an hour!



Options Verify Catalog

This option is provided to enable verification of the catalog index as it is opened. This option 
should only be turned on if it is suspected that the catalog has been corrupted. 

When this option is on, as each catalog index record is read, the corresponding catalog 
record is also read    and checks are made to insure that they agree. If they don't, the bad 
records are removed from the catalog.

Note: with this option enabled, it will take much longer to open a catalog. Once the catalog 
has been read in, the option should be turned off.



Options Slide Show Options

This dialog provides for setting and changing the following options:
1. Minimum delay between slides. This is the minimum amount of time that a slide will be 

displayed before reading in the next slide.
2. Minimum number of animation passes. For FLIC animations, this controls the number of 

times that am animation sequence will be repeated.
3. Display file name. Controls whether or not to display the file name on the screen.
4. Pause between. Wheter or not to automatically proceed from one slide to the next. If 

pause is specified, the right mouse button must be double-clicked to proceed to the next 
slide.

Slide Show Options are stored in the .INI file and will be recalled the next time that PixFolio is
started.



Options Default Options

This command displays a dialog box enabling you to establish startup options that take 
effect when PixFolio is started up. The options that can be set are:

1. Default Catalog, the initial catalog that will be selected.

2. Default    file extension list that will be used to set up the corresponding option in the 
Select Catalog function when a catalog is created. An extension file list is a series of 
wildcard file specifications. Multiple selections can be made; each selection must be 
separated by a semicolon ";". An example is: "*.GIF; *.TGA" to display GIF and Targa
files.

3. The default subdirectory that will be in effect initially. Once a new catalog is selected, 
the current directory will be set to that of the catalog. If this option is not specified, 
the initial subdirectory will be that of the default catalog.

4. Warning messages are to be displayed. Warning messages for the session only can 
be changed via the Options Display Warnings command.

5. Background type is to be a solid color or a dithered color. 

6. Center Image option.



Options Fix Tiff

Certain TIFF files have been found which do not adhere to the TIFF standard. These files do 
not    have the correct strip byte counts. Without this option turned on (this is the default), 
these files will fail. Inspection of Tech Info will reveal the message "Check Tiff: bad offsets." 

If you get the above error when reading a TIFF file, you may be able to read the file by 
turning this option on. If the file reads successfully, it is suggested that you save the file with
PixFolio. PixFolio will write the file in the correct format so that it can be read later with no 
problems.

The files affected by this option are files created by a conversion program "BLKTOTIF.EXE 
which converts Fontasia block files to TIFF format.

WARNING: This option should remain off when reading    a TIFF file unless the file has failed 
to load with the "bad offsets" error. With this option turned on, legal TIFF files may fail to 
load properly.



Capture Window

Selecting this function will allow you to capture the contents of a window from any 
application and create a PixFolio image view window. You can then save this window if 
desired. 

When you select this option, the cursor will change to a distinctive window otuline shape. 
Position this cursor over the window that you wish to capture and click the left mouse 
button.

Note: If you wish to select a dialog box for a capture operation, you must click on the frame 
or tile bar or outside of any control (button, checkbox, listbox, etc) of the dialog box. Clicking
on a control in a dialog box will result in only the control being captured.



Capture Client

Selecting this function will allow    you to capture the contents of the client area of any 
application's window. See Capture Window for more details.



Capture Full Screen

This function works similar to Capture Window and Capture Client except that it captures the
entire screen.



Capture Hide
This option toggles on or off the ability to hide PixFolio while capturing a window. If enabled, 
PixFolio will be restored once the capture is complete.

See: Capture Window, Capture Client and Capture Full Screen.



Palette Dib's Palette

Select this option to open a window that will display the palette for the currently active 
image window.



Palette System Palette

Select this option to display the current system palette.



Palette Change Palette

This command allows you to adjust    the brightness and/or the contrast of an image. Which 
option is selected is determined by the state of the two radio buttons labelled "Brightness" 
and "Contrast.".

The brightness has a range of -200 to +200 and the contrast has a range of -10 to +10.    A 
positive value for brightness will brighten the image, a negative value will darken it. 
Increasing the brightness will make all of the colors brighter by an equal amount. 

Contrast on the other hand alters the brightness of colors unequally. A positive value for 
contrast will increase the contrast while a negative value will decrease the contrast.
If you have an image with a very dark background, an adjustment of the contrast, say by -2, 
may be in order. Once details in the dark areas become discernable, the brightness may be 
increased.

Making contrast and brightness adjustments can result in a loss of image detail. You should 
be aware of this when attempting to find the right adjustment to make. You should avoid 
making an adjustment and then backing up. For example, adjusting the brightness by 100 
and then backing up by -50 will result in loss of detail for the brighter colors, resulting in a 
"posterized" image. If you try an adjustment that is too much, restore the palette using the 
Restore Palette command    and then adjust the brightness or contrast again using a smaller 
value.

Although a brightness and contrast adjustment cannot be made concurrently, it is 
permissible to, for example, to make an adjustment to the contrast and then follow with an 
adjustment to the contrast.

This command is enabled only if your video driver supports a palette. The VGA driver 
shipped with Windows does not support palettes.

The original palette can be restored with the PALETTE RESTORE PALETTE. (Unless it is a 24 
bit color image).

Note: 24 bit color images do not have a palette so invoking this command while displaying a 
24 bit color or gray scale image    requires that    all of the RGB    values in the image must be 
changed and new bitmaps rebuilt. This can take quite a while if your video driver does not 
directly support 24 bit color. It is suggested that 24 bit color images be saved as 8 bit (256 
color) images first. PixFolio and Windows can process 8 bit color images much faster and if 
your video display only supports 8 bit color, you will not lose much picture resolution.

The huge memory requirements of a 24 bit color image preclude saving a copy of it so that it
can be restored so the PALETTE RESTORE PALETTE function is not available for 24 bit 
images.



Palette Gray Palette

This Command converts a color image to a gray-scale image. 

Conversion of 24 bit color images can be lengthy. See PALETTE CHANGE_PALETTE.

The original palette can be restored with the PALETTE RESTORE PALETTE.(unless it is a 24 bit
color or gray scale image).



Palette Restore Palette

This command restores the original    Palette that you had before doing a PALETTE CHANGE 
PALETTE    or PALETTE GRAY PALETTE command.

This command is enabled only if your video driver supports a palette. The VGA driver 
shipped with Windows does not support palettes. Because of the huge memory 
requirements,    this command is not available for 24 bit color or gray-scale images.

Important: Because Windows remaps the colors in an image whenever a new bitmap is 
created, the palette cannot be restored if any editing of the image has taken place. This 
includes rotating and resizing the image as well as the crop and expand image commands. If
you need to adjust the palette and also do any editing to your image, do the editing first and
the palette adjustment last.

This command restores the original palette from before    PALETTE_CHANGE PALETTE was 
run.



Palette DIther 
This command converts the currently displayed color image to a 16, 20 or 256 color dithered
image using the Stucki filter algorithm. The image can also be converted to black and white 
using the Burkes filter algorithm.

Dithering replaces colors that cannot be displayed by the video display with patterns of dots 
of colors that it can display. This tricks the eye into seeing the desired color. 

The degree of dithering is determined by which palette is used to perform the dither. The 
following options are available:

1. Black and white. The dithered image will only contain 2 colors. This may be desirable 
in preparation for printing since many printers, except for color printers, can only 
print black or white and don't know what to do with shades of gray. (Note that most 
of the print drivers distributed with Windows 3.1 do a good job of printing color 
images as halftones and do not require that the image be dithered to black and white
first.)

2. Color (use current palette). This option is available when a 24 bit image is displayed. 
This will most likely be a 256 color palette.

3. 16 Color palette. This palette is good for displaying images on a 16 color video 
display and if you wish to save the image with 4 bits per pixel color resolution.

4. 20 color stock palette. Use this palette to display images with the Windows standard 
20 color palette and with video drivers such as the standard VGA driver.

5. 256 color Palette. This palette has an even distribution of all colors. This palette may 
be used to provide a common palette for cutting and pasting several images that 
have different palettes.

6. Clipboard palette. You may use the palette of another image by copying it to the 
clipbard. This also copies the image's palette to the clipboard. A palette from the 
clipboard may be used to provide a common palette for cutting and pasting several 
images that do not have the same palette.

This option should be selected to dither an image if you want to save it.    Images dithered 
with the Auto Dither command will be saved using the original color and pixel data.



Options Play Image

This    command when selected will "replay"    a GIF87a animation or a GIF89a composite 
image. This command is only enabled if such an image was read. 

GIF animations consist of a series of images that are displayed one by one in succession . 
The Single Step command can be used to step through an animation and the Set Play Rate 
command can be used to set the speed of the animation.



Options Single Step Play

This menu option will toggle an option to either single step through a GIF animation 
sequence or play the sequence normally. When the menu is checked, GIF animation 
sequences will be played one frame at a time.    To proceed to the next frame, double click 
the mouse in the window where the image is displayed or press any key.



Options Set Play Rate

This command can be used to vary the delay time between successive frames in a GIF87a 
animation sequence. The time is entered in 1 thousandths of a second (milliseconds). A 
larger delay will slow down an animation sequence. The default    setting is 100 milliseconds.

Note: This command only affects GIF87a animations. The delay between frames for GIF89a 
animations is defined within the GIF image itself by the creator of the image.



Catalog Alpha Sequence

This command toggles alpha sequence display mode on and off. When in alpha sequence    
the thumbnails will be displayed by name in alphabetic sequence. Otherwise, they will be 
displayed in the sequence that the user has placed them. (See "Moving Thumbnails under 
Catalog Thumbnail Options) The current display sequence is indicated by a checkmark. If 
marked, PixFolio is currently in Alpha sequence mode.

Once a thumbnail    has been manually moved, the thumbnail    view is    taken out of 
alphabetic sequence mode. To return to alphabetic sequence display mode,    click on this 
command. 



Window Tile

Select this option to rearrange all of the non-iconic child windows side-by-side.



Window Cascade

Select this option to rearrange all of the non-iconic child windows stacked on top of each 
other.



Window Arrange Icons

Select this option to rearrange all of the    iconic child windows along the bottom of the main 
window.



Window Close All

Select this command to close all of PixFolio's child windows.This command will restore the 
size of the window to that of the image if the window dimensions have bee altered by the 
Window Tile or Window Cascade commands.



Size Window to Image

The currently active window will be resized to the dimensions of the image displayed in it. 
This command will be particularly useful after window dimensions have been altered by the 
Window Tile command



Context Sensitive Topics

This Help system includes topics that you can call directly from the PixFolio sample 
application. To get context-sensitive help from PixFolio, press Shift+F1 and click on any 
element of the PixFolio application window. You can also highlight any PixFolio menu 
command using the keyboard and press F1 to get help on the command. 



Exit PixFolio

Several methods may be utilized to exit PixFolio.
1.. Select    CLOSE from the system menu or double-click on the system menu icon.
2.    Select EXIT from the FILE menu    or press ALT-F4
3.    Select CLOSE from the FILE menu. However, if an image is currently being      

                viewed from    the thumbnail layout screen, only that image will 
be closed.



Edit Window

When displaying an image in the Edit window, the mouse may be used to select an area for 
subsequently copying or cutting to the clipboard or to select and stretch a portion of the 
image.



Maximize Icon

Press this icon to make the screen the maximum size. This may be desirable before 
executing the VIEW-LAYOUT THUMBNAILS option.



Minimize Icon

This icon may be pressed to reduce the screen to an icon. The icon may be selected later to 
restart PixFolio where you left it.



Sizing Border

The size of the image displayed may be altered by dragging the mouse on the sizing border 
to make the window larger or smaller. The image's size can be permanently changed to the 
new size by use of the EDIT-EXPAND function. 

If thumbnails are currently being displayed as a result of the VIEW-LAYOUT    THUMBNAILS 
command, the number of visible thumbnail windows will be increased or decreased in 
accordance with the new area of the window.



System Menu

The    system menu can be used to exit (close) PixFolio or to move the window (move).



Title Bar

The title bar will contain (if an image is currently displayed, the filename, size and color 
resolution of the image.





Windows Keys

Choose from the following list to review the keys used in Windows:
Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys

PixFolio Keys Keys defined by PixFolio.



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left Arrow Moves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.

SHIFT+F1 Changes the pointer to  so you can get Help 
on a specific command, screen region, or key. You can then 
choose a command, click the screen region, or press a key or 
key combination you want to know more about.

(This feature is not available in all Windows applications.)



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.



PixFolio Keys

Key(s) Function

     ESCAPE key Can be used where ever a Cancel button is displayed.

      CONTROL + INS Copy to the clipboard. See Edit Copy.

      SHIFT + DELETE Cut a portion out of an image. See Edit Cut.

      SHIFT + INSERT Paste from the Clipboard to the current image. See Edit Paste.

      SHIFT + F12 keys Save an image. See Edit Save.

F12 Save an image, and change file name or format.    See Edit 
Save.

      CONTROL + F12 Open image. See File Open.

      CONTROL + SHIFT +F12 Print image. See File Print.

      ALT + F4 Exit PixFolio.

      BACKSPACE + ALT Undo last edit operation. See Edit Undo.

      CONTROL + "P" "Play" a GIF animation sequence.
 



Clipboard

The Clipboard is used by PixFolio to transfer bitmap information to and from other applications that utilize 
compatible formats. PixFolio only supports standard Windows Clipboard formats: palette info, device 
dependent bitmaps and device independent bitmaps or DIB's, metafiles and text. Several additional 
formats are supported in conjunction with OLE: "Native" and "ObjectLink".

The Cut or Copy commands transfer image data from PixFolio to the Clipboard. If a region is not selected 
by using the Mouse and the left mouse button, the entire image will be copied to the Clipboard.

The Paste command can be used to transfer a image or portion of an image in the clipboard to your 
current image. Selecting Paste will change the cursor to a crosshair. Then, while you hold the left mouse 
button down, a box whose dimensions are the same as the Clipboard data can be moved around until it is
positioned properly. Releasing the left mouse button will allow the clipboard data to be displayed.

The Paste Palette command    can be used to replace the current palette with one from another image in 
the clipboard. When the Cut or Copy commands are used, a copy of the palette in use is also copied to 
the Clipboard. This palette can then be "pasted" just like the image except that    not being an entity in the 
physical sense, it is not necessary to position it.    While pasting a palette may be necessary in some 
instances, the use of this function is limited; the images must have a similar color map structure to avoid 
unwanted changes to the colors in the image.



Device Independent Bitmap (DIB)

Device Independent Bitmaps are a way of representing an image in a manner that is independent of the 
hardware upon which they are displayed. 

DIB's are used to store images which must be displayed in a number of different environments. They 
contain all elements which might be needed by different display hardware. Windows BMP files are simply 
DIB's with a header tacked on.



Device Dependent Bitmap (DDB)

Device dependent Bitmaps are a way of representing an image that is dependent upon the hardware 
characteristics of the display device. Windows uses DDBs internally. However, a DDB created for one 
device such as VGA    can only be used for VGA. For this reason, the DIB format is used when images 
must be transferred to another environment.



Color Resolution

Windows can handle four different color resolutions defined as bits per pixel or the number of bits used to 
describe the color.. 1 bit of color resolution can result in 2 colors, (usually Black or White). 4 bits will allow 
for 16 colors. 8 bits will allow for 256 colors. These are the most common values found in most images. 
Note that in order to display 256 colors, you must have a    video board and Windows video driver capable
of displaying 256 colors; the standard VGA driver can only display    16 colors.

Many    images produced by scanners have 24 bit color resolution which is good for several million colors. 
Unless you have one of the newer graphics cards capable of displaying 24 bit color, 24 bit images will be 
displayed in 8 bit mode.    



GIF

GIF stands for Graphics Interchange Format. It is a bitmapped graphics format introduced by 
CompuServe. "The Graphics Interchange Format (C) is the Copyright property of CompuServe 
Incorporated. GIF (sm) is a Service Mark property of CompuServe Incorporated".

There are two specifications for GIF images in use. The older of the two is the "GIF87a" format. Most GIF 
images adhere to this format. A newer file specification, "GIF89a" provides for additional features such as 
text and graphic overlays which can be timed or keyed to user input. PixFolio supports these features.



Bitmap

A bitmap in the general sense is an array of pixel (picture elements) . A bitmap to Windows , being a 
Graphical environment, is the basic element of the windows display just like a character is in an non-
graphical environment. The windows display is made up of scores of bitmaps, large and small which 
make up different elements of the display. Bitmaps are used for such things as buttons, frames, title bars 
and also text. 

The term Bitmap can also be used more specifically to refer to an image stored on disk. Commonly, these
files have a .BMP extension. BMP files consist of a Windows bitmap along with some header information 
such as the size of the image, etc.



JPEG
JPEG is a file compression method that differs from other compression methods such as LZW, used in 
GIF files, or Huffman coded or Run Length Encoded (RLE) in that the compression is "lossy"; the 
compressed file looses some of the detail of the original. This is possible because the human eye and/or 
the user's video display is incapable of distinguishing all of the information that can be present in an 
image. JPEG enables this unnecessary information to be eliminated, resulting in much smaller 
compressed files than would be produced using other compression methods.

The JFIF file format and the software implementation used in PixFolio is the work of the Ïndependent    
JPEG Group". 



OLE (Object Linking and Embedding)

PixFolio will act as an OLE server in conjunction with other applications (Word for Windows, Write and 
PBrush are examples in Windows 3.1) known as an OLE Client. Applications that support OLE will 
generally have an "Insert Object" menu command that will present the user with a list of registered OLE 
servers. To start PixFolio, select "PixFolio Image". 

When initiated by an OLE client, PixFolio will be started, if not already running. A Thumbnail view window 
for the default catalog will be opened automatically. To select a thumbnail, double click on it with the left 
mouse button or after viewing it, select Update from the file menu. This will create an embedded object in 
the Client application's document.

To create a link to a PixFolio-cataloged image, copy the desired image to the clipboard using EDIT COPY.
Then, in the client application, select "Paste Special" to link the object to PixFolio.



Metafile

A metafile is a Windows file that contains drawing commands that can be used to draw an image. These 
commands can be to draw a line, draw a circle, rectangle or other geometric object or a bitmap. Metafiles 
usually take much less storage space to define an image than using a purely bitmapped image format. 
This is because it takes much less data to describe a line by it's endpoints rather than a collection of 
pixels.

PixFolio uses metafiles in lieu of creating a bitmap for Micrografx DRW files and WordPerfect WPG files. 
Other metafile formats are Windows Clipboard CLP files and Windows MetaFile WMF files. 

Metafiles consisting of vector drawing commands are easily resized whereas bitmaps are difficult to 
resize unless it is by some integer factor.



User Guide

A printed user guide may be obtained by loading file USRGUIDE.WRI into Windows WRITE 
and printing it on your printer.


